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 Gruppenarbeit 
 

 
 
 
Meine Rolle in der Gruppe:   

 . 
 
Was ich machen muss: 

•   

•   

•   
 
 
Ich sage dabei: 
 
 
 
 
 
 
 
 
 
 
 
 
Was schwierig sein kann:  . 
 
 
Was Spaß macht:  . 
  
 
 
 
 
 
  

Reproduced from Alberta Learning, Kindergarten to Grade 9 Health and Life Skills Guide to Implementation (Edmonton, 
AB: Alberta Learning, 2002), p. C.31. 
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Wie ich meiner Gruppe helfen kann 
 
 
 
Name:   Datum:   
 
 
Wenn wir Gruppenarbeit machen, und jemand: 
 
 den Sprecher die ganze Zeit unterbricht, bin ich    
 
 Was kann ich dagegen machen? Ich kann  

 streitet, bin ich   
 
 Was kann ich dagegen machen? Ich kann  

 andere beleidigt, bin ich   
 
 Was kann ich dagegen machen? Ich kann  

 sich die ganze Zeit beschwert, bin ich   
 
 Was kann ich dagegen machen? Ich kann  

 nur Dummheiten macht, bin ich   
 
 Was kann ich dagegen machen? Ich kann  

 immer alles vorsagt, bin ich   
 
 Was kann ich dagegen machen? Ich kann  

 nicht auf andere hört   
 
 Was kann ich dagegen machen? Ich kann  

 nicht beim Thema bleibt, bin ich   
 
 Was kann ich dagegen machen? Ich kann  

 fast nichts sagt, bin ich   
 
 Was kann ich dagegen machen? Ich kann  

 
Adapted from Alberta Learning, Kindergarten to Grade 9 Health and Life Skills Guide to Implementation (Edmonton, AB: 
Alberta Learning, 2002), p. C.33. 
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 Wir denken nach 
 

 
 
Name:   
 
Datum:   
 
Thema:   
 
 

Was habe ich (haben wir) gemacht? Was haben wir erreicht? 

 
 
 
 
 
 
 
 

 

Was könnten wir jetzt machen? 
 
 
 
 
 
 

Was habe ich gelernt? 
 
 
 
 
 
 
Wie kann ich das Gelernte in der Zukunft anwenden? 
 
 
 
 
 
 

 
 
 
  
Adapted with permission from Eric MacInnis, Ross MacDonald and Lynn Scott, Controversy as a Teaching Tool (Rocky 
Mountain House, AB: Parks Canada, 1997), pp. 74, 75. 
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Meine Gedanken zum Thema 
 

 
 
Name:   Datum:   
 
Was ich über das Thema weiß:   

  

  

  

  

  
 
 
Das sind einige Zeichnungen über   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  

 
 
Das sind meine Fragen:   
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How to Use KWL Charts 
 

 
 

Think about what you already KNOW about your topic. List those 
facts in the first column. 

 
For example, if your topic is “How I Talk to Others in a New Language,” you may come 
up with these ideas. 
 

What I know What I want to find out What I have learned 

• Can use hand gestures 
and facial expressions 
to help the other 
person understand 

• Don’t be afraid to 
make mistakes!  

  

 
 

Think of the kinds of information you WANT to find out. List specific 
questions in the second column. 

 

What I know What I want to find out What I have learned 

• Can use hand gestures 
and facial expressions 
to help the other 
person understand 

• Don’t be afraid to 
make mistakes! 

• What to do if I don’t 
know how to say a 
word 

• What to do if I don’t 
understand what the 
other person is saying 

 

 
 

LEARN the answers to your questions. List that information, and 
anything else that you learn about your topic, in the third column. 

 

Step 1 

Step 2 

Step 3 

 

Microsoft Word allows you to create your own chart electronically 
using the options in the Table menu. 
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How to Use a Brainstorming Web 
 

 
 

 

Identify your topic and use it as the title. Write it in the centre of your web. 
 

 
 
Identify categories of information and label each of the outer bubbles. 
 

 
 
Brainstorm and jot down ideas in each category. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Step 1 

Step 2 

Step 3 

Thema 

Idee 

Idee 

Idee 

Idee 

Idee 
Idee 

 

Newer versions of Microsoft Word have a web-building option listed  
under Diagram on the Insert menu that lets you create your own 
web electronically. 
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Ideensammlung 
 

 
 
Name:   Datum:   
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Ich denke nach  
 

 
 

1. Hauptidee 

  

 
3. Tatsachen 

  

  

  

  

  
2. Zeichnung  

  
 

4. Beispielsatz 

  

  

  

  

 
5. Beispiele 

  

  

  

 
 

 

 

6. Andere Informationen  

  

  

  

 
7. Definition 

  

  

 
  
Reproduced with permission from Edmonton Public Schools, Thinking Tools for Kids: Practical Organizers (Edmonton, AB: 
Resource Development Services, Edmonton Public Schools, 1999), p. 178. 
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How to Use a Mind Map  
 

 
 

Identify a topic and use it as the title. Write the word or draw a picture in 
the centre of your mind map. 
 
Identify categories of information, and label or draw a picture in each of 
the outer bubbles. 
 
 

Create subcategories of information to expand on your mind map. 
 

 
Use as many pictures, colours, imagery, and key words as you can to 
create your mind map. 

 
 
 

 
 
  
From Alberta Learning, Kindergarten to Grade 9 Health and Life Skills Guide to Implementation (Edmonton, AB: Alberta 
Learning, 2002), p. 93. 

 

 
Me 

 

 

How I 
learn best  

 

  

Believing 
it’s important  

Caring 
about it 

 

 Read about it 

Time to think 

 

 
  

   

 

Write about it 

 

 

Discuss 

 

 

Why? 

  

 

Why 
not? 

Step 1 

Step 2 

Step 3 

Step 4 
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How to Use Venn Diagrams 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Label each side of the diagram with the name of each item you are 
comparing. 

 
 

Think about all the unique features or characteristics of the first item 
and write your ideas in the left part of the diagram. 

 
 

Think about all the unique features or characteristics of the second 
item and write your ideas in the right part of the diagram. 

 
 

Think about all the features the items share and write your ideas 
in the middle of the diagram. 
 

Characteristics or features 
that are the same for 
both items 

Characteristics or 
features that are 
unique to another 
item 

Characteristics or 
features that are 
unique to one 
item 

Step 1 

Step 2 

Step 3 

Step 4 

 

Newer versions of Microsoft Word have a Venn diagram option listed 
under Diagram on the Insert menu that lets you build your own Venn 
diagram electronically. 
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Der Kreis der fünf Sinne 
 

 
 
Name:   Datum:   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  riechen 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Thema 

Schmecken 

 fühlen 

hören sehen 
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T-Tabelle 
 

 
 
Name:   Datum:   
 
 
Thema:   
 

   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  

 

 

 



  

Y-
Ta

b
el

le
 

   N
a

m
e:

  
 

D
a

tu
m

:  
 

  
 

 
 

 
Fü

hl
t s

ic
h 

an
 w

ie
  

 

 
             

Hö
rt 

sic
h 

an
 w

ie
  

             
Si

eh
t a

us
 w

ie
 

 

 
 

 
 

 

 

 A p p e n d i x  D :  G r a p h i c  O r g a n i z e r s  

 
D–17 



 

________________________________________________________________________________ 
  D-18 G r a d e  4  t o  G r a d e  6  G e r m a n  L a n g u a g e  A r t s   

W-6 Tabelle 
 

 
 
Name:   Datum:   
 
 
Schreibe Fragen über dein Thema. 
 
Wer? 
 
Frage nach den 
beteiligten 
Personen. 

 

Was? 
 
Frage nach Sachen 
und Ereignissen. 

 

Wo? 
 
Frage nach Orten, 
Stellen und Plätzen. 

 

Wann? 
 
Frage nach Daten 
und Uhrzeiten. 

 

Warum? 
 
Frage nach dem 
Grund, der Ursache 
oder dem Zweck 
einer Sache. 

 

Wie? 
 
Frage nach der Art 
und Weise, wie 
etwas geschieht. 

 

Wenn…? 
 
Frage nach Folgen 
oder 
Konsequenzen. 

 

 

 



  

Ta
ge

sa
b

la
uf

 
   N

a
m

e:
  

 
D

a
tu

m
:  

 
   

 

 

 

 

 

 

 

 

 

 

 
 

 
 

 
 

 
 

 

 
 

 
 

 
 

 
 

 

 
 

 
 

 
 

 
 

 

 
 

 
 

 
 

 
 

 

 
 

 
 

 
 

 
 

 

 

 

 A p p e n d i x  D :  G r a p h i c  O r g a n i z e r s  

 
D–19 



 

________________________________________________________________________________ 
  D-20 G r a d e  4  t o  G r a d e  6  G e r m a n  L a n g u a g e  A r t s   

How to Use PMI Charts 
P-M-I Karte (Plus–Minus-Interessant) 

 

 
 

Plus: Think about all the advantages and good reasons for making the 
choice. 
 

 
Minus: Think about all the disadvantages and the downside of making 
the choice. 
 
 
List any information that is neither positive nor negative as Interesting. 

 
 

 
Example: A PMI chart that shows the advantages and disadvantages of using the 

Internet as a research tool 
 

Using the Internet as a Research Tool 
 

Plus Minus Interesting Information 
 
• There is a lot of 

information. 
 
• You can look at a 

number of different 
sources in a short 
period of time. 

 
• You can do your 

research in the 
comfort of your home 
or classroom. 

 
• If you do not know 

how to search well, it 
can take a long time 
to find what you 
need. 

 
• There is no guarantee 

that the information 
you find is accurate 
or of good quality. 

 
• The reading level of 

factual and historical 
information may be 
high. 

 

 
• Many teenagers know 

more about using the 
Internet than some adults. 

 
• Anybody can post 

information on the 
Internet. There are no 
rules to follow, no licenses, 
etc. 

 
 
 
 
 

Step 1 

Step 2 

Step 3 

 

Microsoft Word allows you to create your own chart electronically 
using the options in the Table menu. 
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Was ich habe und was ich brauche 
 

 

 
 
Welche Frage habe ich? 
 
 

 
 
Welche Möglichkeiten habe ich, die Frage zu beantworten? 
A. B. C. 
 
 

 
 

Welche Möglichkeit ist die Beste? 
 
 

 
 
Welche Mittel habe ich? 
1. 
2. 
3. 

 
 

Welche Mittel brauche ich? 
1. 
2. 
3. 

 
 

Mein Plan in drei Schritten: 
1. 
2. 
3. 

 
 

Wich kann ich herausfinden, ob meine Entscheidung die Richtige ist? 
 

 
  
Reproduced with permission from Edmonton Public Schools, Thinking Tools for Kids: Practical Organizers (Edmonton, AB: 
Resource Development Services, Edmonton Public Schools, 1999), p. 232. 
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Ich treffe eine Entscheidung 
 

 
 
Das Problem:   Die Wahlmöglichkeit:   
 
 Pro + Contra – 

Fakten:   

  

  

  

  

  

  

  

  

  

  

  

 

Gefühle:   

  

  

  

  

  

  

  

 

Neue Ideen:   

  

  

  

  

  

  

  

  

  

 

Meine 
Entscheidung: 

  

  

 

Begründung für 
meine 
Entscheidung: 

  

  

 
  

Adapted with permission from Eric MacInnis, Ross MacDonald and Lynn Scott, Controversy as a Teaching Tool (Rocky 
Mountain House, AB: Parks Canada, 1997), p. 61. 

 

 



 

________________________________________________________________________________ 
   D-24 G r a d e  4  t o  G r a d e  6  G e r m a n  L a n g u a g e  A r t s   

IDEA Decision Maker 
 

 
 
 
 
 
 
 dentify the problem 

   

   
 
 escribe possible solutions 
  

A B C 
   

 
valuate the potential consequences 
of each solution 

 
   

 
ct on the best solution 

  
 
 
 
 
 
 
 
 
 
 
 
How did your IDEA work? 
(Evaluate your results.) 

  

  

I 
 
 
 

D 
 
 
 
 
 
 

E 
 
 
 
 
 
 

A 
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Welche Möglichkeiten gibt es? 
 

 
 
Das Problem: (eine Entscheidung treffen oder einen Konflikt lösen)   

  

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Mögliche Folgen:   

  

  

  

Option:   

  

  

  

1 

Mögliche Folgen:   

  

  

  

4 Option:  

  

  

  

Mögliche Folgen:   

  

  

  

3 Option:   

  

  

  

Mögliche Folgen:   

  

  

  

2 Option:   
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Influences on Decision Making 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Questions you need to ask to help you make this decision 

    

    

    

    

Decision to be made 

  

  

  

  

Family Peers 

Cultural beliefs Values 
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Zielsetzung Karte1 
 

 
 
Name:   Datum:   
 
 
 
Mein Ziel   

  

  
 
 
Das ist mein Ziel, weil  

  
 
 
Um mein Ziel zu erreichen, werde ich: 
 
 
 
1.   
 
 
 
2.   
 
 
 
3.   
 
 
Ich brauche _______Tage, um mein Ziel zu erreichen. 
 
Habe ich mein Ziel erreicht? 
 
  Ja 
   

  Fast 
   

  Nein 
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Zielsetzung Karte 2 
 

 
 
Datum:   
 
Name:   
 
 

Ziel Mein Ziel ist es, … 
 
 
 
 

Begründung Ich setze mir dieses Ziel, weil  … 
 
 
 
 
 

Mein Plan Um mein Ziel zu erreichen, werde ich … 
 
 
 
 
 
 
 
 
 

Kontrollieren Wie kann ich feststellen, ob ich erfolgreich gewesen bin? 
 
 
 
 
 
 

Nachdenken Was hätte ich auch machen können? 
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Zielsetzung Karte 3 
 

 
 
Name:   Datum:   
 
 

Zielsetzung: Klein anfangen 
 
 
Mein „großes“ Ziel   

möchte ich am    ___________ (Datum) erreichen. 
 
 
Schritte, die mir helfen werden, mein „großes“ Ziel zu erreichen: 
 

Mini-Ziel А  Mini-Ziel B  Mini-Ziel C 

  

  

   

  

   

  

 
Ich werde:  Ich werde:  Ich werde: 

•   

•   

•   

Datum   

 

 •   

•   

•   

Datum   

 

 •   

•   

•   

Datum   

 
 
 
 
 
 
 
 
 
 
 
 
Ich werde wissen, dass ich mein “großes” Ziel erreicht habe, wenn   
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Zielsetzung Karte 4 
 

 
 
Name:   Datum:   
 
 

Was kann deine Zielsetzung beeinflussen? 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Ziel 
 
  
 
  
 
  

 

 


